Hands-on demo on high performance 3D Data
Visualization using ParaView

Martin Huarte-Espinosa
martin.huartee@gmail.com




Get started!

Download data samples from:
https:/tinyurl.com/shpcp-vis

Make sure you save data into the Downloads folder so
you can easily find them.

If you have not done so yet, download and install
ParaView from:

https.//www.paraview.org/download/

Version | e

ParaView macos
X ParaView-5.6.0-MPI-OSX10.8-64bit.unsigned.dmg

X ParaView-5.6.0-MPI-OSX10.8-64bit.pkg

L ParaView-5.6.0-MPI-OSX10.8-64bit.dmg



https://tinyurl.com/shpcp-vis
https://www.paraview.org/download/

Paraview’s GUI
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Important buttons (for now)

i, 2
open data undo redo

WX X Y =Y 2z 2z el &
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camera & rotation controls



Let’s load some data

Paraview provides some examples to help you learn.
Let's use disk out ref.ex2:

- Output from a simulation of air flowing around a hot,
spinning disk

- Has a cylindrical
simulation domain/grid

- Contains the data of the
grid & the air




Load disk _out_ref.ex2

1. Open |V=

800 M Open File: (open multiple files with <ctrl> key.)
2. Select dat o
. oeleCl dala :
(] Macintosh HD Filename
(1] Google Chrome ' blow.vtk
(] home 7 bluntfin.vits
3 net 7 bot2.wrl
3 S I t (] Microsoft Office 201 " box.ex2
e J H (1] Acrobat 11 | can.ex2
: eCl| ¥ variables ~ S il
| cone.vtr
= | i disk_out_ref.ex2
g Data  dualSphereAnimation.clone.pvd
[ singleSphereAnimat | dualSphereAnimation.pvd

r-:_'-u App'y (] Symmetricimpact3 " elements.viu
. A [ data 7 initial.z0.cosmo
File name: |disk_out_ref.ex2 \ OK

Files of type: | Supported Files (*.inp *.cosmo *.cml *.csv *.txt *.CSV*Tx + | | Cancel |




5. Choose this representation:

- Surface
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Use the mouse to move the data around.

Air

Disk (not shown)

would be In this
volume.

Air flow pressure. This is a 3D surface color map. Clearly
shows changes as a function of position on the surface
only.



v Variables

Loads ALL the data so it is available for
visualization

disk _out ref.ex2is small

Not a good idea when using large data; the
system may slow down or crash.



Explore other representations.
i R & (e 3| ) EL

\

Pressure surface with edges.
Shows pressure vs. position
along the geometry of domain’s
cells at the surface.

Solid color surface.
Shows the surface of the
computational domain and
its geometry.




Representations show different data components

within the same space. Depends in what YOU
want to see.

Wireframe of pressure. Shows

pressure vs. position on the
domain’s grid.

Volume rendering of
pressure. Shows the field all
the way through the volume.




Note that the actual data consists of values of each
variable (pressure, temperature, etc.) at a set of points
located in a cylindrical structure.

A surface/volume map
(below) is the result of
interpolating the data.




Explore other variables.

4k

B & S | o Pres ||

A| | Surface

4k

| | Surface With Edges : |

E.g. | (@) cellNormals [ X

Magnitude of unitary vectors
parallel to the x axis.

Useful to compute air flows in/out
the domain or pressure acting on
the air, along the x axis.

May be used in the design of the
disk.




Let’'s make our previous example clearer by adding a
color legend.

Click:

cellNormals

—=0.8

Note you can move the bar using the mouse.

>

Modify the legend using ws &0



Color map editor

- CO I O rS & th ei r 8.0.06 # Preset Color Scales (x N5 Color Map Editor
d IStrI butlon Name Color Space [ Import | [Search. . i e
Cool to W Divergi L
B W cooltowarm g " Export | || Interpret Values As Categories
I ] sietoRedRai.. HSV e
Mapping Data
I 7 RedtoBueRai... HSV | Normalize |
- La be I S -:I Grayscale RGB [ *Re’n?dve*l / .
[ xRay Hes. 0.018:0:526
B | sietoYelow  RGB =
I | Black-Body Radi.. RGB o
L . /I I CElabBlueto... CIELAB @
- Linear/i0g B | oo Bueand... RGE =
scales B | 5o oo 73 —— o
e
[-j Cold and Hot RGB
B M Reinvow Desaw... RGB Qi 0.0175618
[.I- Rainbow Blende... RGB Close [V Use log scale when mapping data to colors
- — | | Enable opacity mapping for surfaces

S Ca I e I i m itS | | Automatically rescale transfer functions to fit data

Color transfer function values

Value R G B
1 0.00678... |0 0 0

FunCtIOnS 2 0.0288185 1 1 K

More details at: http://www.kitware.com/blog/home/post/573



Visualization algorithms or filters

To show exactly what you want, and to perform

analyses m Tools Macros Help
Search... \_Space
- Isosurfaces Recent >
- Cutting planes AMR >
- Streamlines i 4
Common b
- G!yphs CosmoTools b
- Clipping Data Analysis >
- Height maps Material Analysis >
Quadrature Points B
Statistics >
Temporal S
Alphabetical 3




-

Slice

Note itaddsonto = =~~~
the pipeline

Q6 Pipeline Broweer

[é] builtin:
@ é disk_out_ref.ex2
& Slice2

First, set

Information |

Properies

properties. -

Search ... (use Esc to clear text)

K <0 > > M 5 Tmefo
Representation . x D, a ;l‘ﬂ ﬁg 3;*.

5 B

Slice Type | Plane
Use the mouse e —

Origin |0 0 0.079999923"

Normal (1 Ilo o '
to O - [ X Normal Reset Bounds

Y Normal

Camera Normal Center on Bounds |

\
[ Z Normal
\

[ ) Crinkle slice
[V Triangulate the slice

Then [ Apply |

= Display

Slice datasets with planes.

log ( pressure )

0.01
I




These buttons are handy now

do/undo g)

change view

-3 I = LSS J5.0 I ol

Note you can activate pipeline objects
using their eyes

@ disk_out_ref.ex2
@ ' Slice2

log ( pressure )

0.01
L —
|
0.00479 0.0288

log ( pressure )
0.01
L —
|
0.00679 0.0288




Vectors and Streamline plots

Add the streamline filter

=
_

to the disk out_ref.ex2 file.

Apply (below)

Then add a tube filter

Filters>alphabetic>tube




Animations -- more controls

View > Animation view

e @

o @ Animation View

Mode:| Sequence + |Time D0143332050149973 | Start Time: 0 | £ |End Time:).004299885044992 | £ |No. Frames: |10

Time

v | TimeKeeper - Time

gr | can.ex2 4| | Use Meta File &




Animations: Camera

1. Place the camera where you want the orbit to start.

2. In the property selection widgets, select Camera in the first box and

Orbit in the second box.

41 | Orbit

y S

“amera

4. Adjust orbit:

!/ Create Orbit

N

Orbit Parameters

Center 0.00312¢ 0.06251¢ 0

Normal -0.2832: 0.95861! -0.0287:

Radius 2.5

(Reset Bounds) ( Cancel ) [ OK )

N

A

? W

K <1 > > > %

+| | Surface

®

cccccc

o B By i3

Time: 0.00107715 0

I R R

»}

Search (\use Esc o clear tex1] ‘,__1
\
= Properties (Temporallnterpolalor\

O ‘Tlme D0107715430861723 YRtart Time:|0

Time

Discrete Time Step
Interval 206

N

o\

v TimeKeeper - Time

L\

Display (UnstructuredGridRepresentation)

N Camera

s [ Orbit

Representation [ Surface

3|

Coloring

(o VEL (Z

+J




About Paraview

ParaView

Parallel Visualization Application

. . L 4
- Interactive visualization and l[

analysis platform for 2D and 3D

scientific & engineering datasets

M) 0 Kitware

Laboratories

- Funded by Department of Energy

A R /\\
csimsoft. - LosAlamos !W!L AsC

NATIONAL LABORATORY

- Open Source . Y,

- Scalable: from single-processor workstations to
multi-processor distributed memory supercomputers.
- Multi-platform: Windows, OS X, Linux

- Extendible modular architecture



Special features

-Supports derived Editor
variables =

- Scriptable via
python

- Animations

-Run in parallel/ yeualization
distributed mode echnolog
for big data

s ) U

Editors’ Choice




Now, let's explore a medical CT scan, headsq.vti. Let’s
produce the plot below (note all objects are in the same
window). Finally, be creative and produce an interesting plot
using ParaViews filters of your choice. Next, ask yourself, can

you do this better?




Load headsq.vti

1. Start a new session

(top left)

2. Open |! ) (top left)

800 M Open File: (open multiple files with <ctrl> key.)
3. Select data i
| ]
(] Macintosh HD Filename
(1] Google Chrome 1 blow.vtk
(] home  bluntfin.vis
3 net 1 bot2.wrl
(L] Microsoft Office 201 | box.ex2
[[] Acrobat 11 1 can.ex2
(] Skype " comb.xyz
| cone.vtr
- § B headsgvti . |
g Data | dualSphereAnimation.clone.pvd
[ singleSphereAnimat | dualSphereAnimation.pvd
(] Symmetricimpact3 | elements.vtu
i data 7 initial.z0.cosmo

File name: |disk_out_ref.ex2 | [ OK

Files of type: | Supported Files (*.inp *.cosmo *.cml *.csv *.txt *.CSV *.TX ] | Cancel |
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Pipeline Browser

E builtin:
& headsq.vti

Properties Information

o6 Properties
m @ Reset ‘ # Delete ?
|Search ... (use Esc to clear text) |@
‘ = Properties (headsq.vti) ‘ @ B QW

Cell/Point Array Status
v 2% Scalars_

r= =

Click the contour filter

& Apply




[ NON | ParaView 5.5.0 64-bit

2 ® BRO ®a F kG KD DDME mmeo 0 |c
G

- = . - 9" e QLo P § £ Pl P g4
B B & S t @ ©Solid Color C . Surface B : x b ‘ (&%
d 90 0 % @ @ & 2 @ & 8 & & *

0@ Pipeline Browser £

B builtin: B R0 [N Boa s 20 R

CELS

@ headsq.vti
il
® & Contourf

i Information
o@ Properties

Apply Reset ¥ Delete

L

Search ... (use Esc to clear text) ]
Properties (Contour1) B || B (s =

Contour By o scalars_

Compute Normals

Compute Gradients

Compute Scalars
Generate Triangles

Isosurfaces a

alue Range: [0, 4095
e >
1 2047.5 ar

Scan frequencies, change and apply




Tools Catalyst Macros Help
\_Space A

Search
Recent
AMR

Annotation

) CTH

1 Common

CosmoTools
. Data Analysis
s Material Analysis
" Point Interpolation
Quadrature Points

Statistics
Temporal

Alphabetical

ation

i Delete

>

VVVVVVVYVYYVYYVYY

\4

|

Scatter Plot

Shrink

T Slice

Slice (demand-driven-composite)

Slice Along PolyLine

Slice With Plane
Smooth
StreakLine

©= Stream Tracer

Stream Tracer With Custom Source
Subdivide

Surface Flow

Surface Vectors

Synchronize Time

Temporal Array Operator
Temporal Cache
Temporal Interpolator
Temporal Particles To Pathlines
Temporal Shift Scale

.z Temporal Snap-to-Time-Step
Temporal Statistics

Tessellate
Tetrahedralize

E Texture Map to Cylinder
Texture Map to Plane
Texture Map to Sphere

BIWEN rcss Bar
Transform

\

B buittin: FRinE HES AR REBEBRA AN 2R

& ©) headsq.vti
~ @ Contourt
@ &) Transform1

Information
Q6 Properties

Apply Reset 3 Delete ?

Search ... (use Esc to clear text)

s Edit %] < &
Styling
Opacity 1
Lighting
Specular 0

OSPRay
OSPRay Use Scale Array

Use the box containing the
head to move data around

Combine w/ shift key to
move but not rotate

Note the box and axes
respond to the mouse
pointer



Tools Catalyst Macros Help fiiﬁiﬂz;w e vE BERMLTEBER AN 0
| Search... \_Space . | S Sl
Recent > ) .
J AMR > Scatter Plot ,
. Annotation > Shrink |
) CTH »  @sSlice
| common > Slice (demand-driven-composite) } 8
CosmoTools b hony )@ Reost ] 3% Do
J Data Analysis > Slice Along PolyLine } e ES:‘”'%“EX“
s Material Analysis 2 1S¢ sond : ‘
Point Interpolation > Slice With Plane Opacity
Quadrature Points > Smooth . ;:mls 0
Statistics > StreakLine osoray
Temporal > Z= Stream Tracer 0SPRay Use Scale Array X

v

Alphabetical

Stream Tracer With Custom Source
Subdivide

Surface Flow

Surface Vectors

Synchronize Time

I
E builtin:
1ation Temporal Array Operator
Temporal Cache

|
B headsq.vti
Temporal Interpolator '

Temporal Particles To Pathlines m COﬂtOUI’1

! Delete ? |
Temporal Shift Scale ¢ )
'z Temporal Snap-to-Time-Step e Transform1
—  Temporal Statistics
B Q) W

Tessellate
E IZZiT:dI\;I?iI;)ZTO Cylinder NOtlce the plpellne

Texture Map to Plane
Texture Map to Sphere

e Bress Bar
Transform



~ &) headsq.vti Click on the data
" 0 Contour1
® &) Transform’

@ Apply another contour

& Apply



builtin:
™ i headsq.vti

Properties Information |

006 Properties

' Apply ) Reset 3 Delete |

\Search ... (use Esc to clear text)

Isosurfaces

Value Range: [0, 4095]

of them to

= Display (GeometryRepresentation)

=2

Representation { Surface

Colarina

& Apply



PARAVIEW -- Python scripting

- http://www.paraview.org/Wiki/ParaView/Python_Scripting

- Scripts can automate visualization algorithms by
performing actions as a user would at the GUI

- Scripts run inside pipeline objects, performing parallel
visualization algorithms

- Useful command line environment to create analysis programs


http://www.paraview.org/Wiki/ParaView/Python_Scripting

Creating a Python Script Trace
Macros Help 1 Reset @
Create Custom Filter...
2. Tools >
Manage Custom Filters...
Manage Links...

Add Camera Link...
Manage Plugins... 3. Build a simple pipeline in the
main ParaView GUI.

Record Test...
Play Test

Lock View Size “MStop Trace

Lock View Size Custom...

Timer Log A python script window will open
Output Window with commands that replicate your
Connect To Catalyst actions.

Python Shell

Stop Trace



Saving scripts

File > Save as >
NAME.py

or
File > Save state
or
File > Save as Macro
it should appear in

the GUI's Macros
menu then

®Be ® Jf untitled.py - Script Editor

try: paraview.simple
except: from paraview.simple import *
paraview.simple._DisableFirstRenderCameraReset()

can_ex2 = ExoduslIReader( FileName=[/Users/martinhuarte-espinosa/Downloads/ParaViewData-v4.1/Data/d

AnimationScened = GetAnimationScene()
AnimationScened.EndTime = 0.004299988504499197
AnimationScened.PlayMode = 'Snap To TimeSteps'

can_ex2.FileRange = [0, 0]

can_ex2. XMLUFileName = YUsers/martinhuarte-espinosa/Downloads/ParaViewData-v4.1/Data/artifact.dta’
can_ex2.FilePrefix = Users/martinhuarte-espinosa/Downloads/ParaViewData-v4.1/Datalcan.ex2'
can_ex2.ModeShape = 21

can_ex2.FilePattern = '9%s'

can_ex2.ElementVariables = ['EQPS]

can_ex2.GlobalVariables = ['KE', XMOM', YMOM', ZMOM', 'NSTEPS', TMSTEP"]
can_ex2.SideSetArrayStatus = []

can_ex2.ElementBlocks = ['Unnamed block I1D: 1 Type: HEX', 'Unnamed block ID: 2 Type: HEX|
can_ex2.NodeSetArrayStatus = []

can_ex2.PointVariables = ['DISPL', VEL', 'ACCL']

RenderViewt = GetRenderView()
RenderViews.CenterOfRotation = [0.21706008911132812, 4.0, -5.1109471321105957]

DataRepresentation27 = Show()

DataRepresentation27.EdgeColor = [0.0, 0.0, 0.50000762951094835)
DataRepresentation27.SelectionPointFieldDataArrayName = 'ACCL’
DataRepresentation27.SelectionCellFieldDataArrayName = 'EQPS'
DataRepresentation27.ScalarOpacityUnitDistance = 1.3901072164734267
DataRepresentation27.ExtractedBlockIndex = 2
DataRepresentation27.ScaleFactor = 1.9778103828430176

RenderViews.CameraViewUp = [0.0, 0.0, 1.0]

RenderViews.CameraPosition = [0.21706008911132812, -47.740573746856327, -5.1109471321105957]
RenderViews.CameraClippingRange = [38.046358729469091, 65.778821972648018]
RenderViewt.CameraFocalPoint = [0.21706008911132812, 4.0, -5.1109471321105957]
RenderViews.CameraParallelScale = 13.391445880217907




Python shell

Macros Help . Useful command line environment for analysis.

| Create Custom Filter... 1
i Add Camera Link...

. Manage Custom Filters...

Manage Links...
| Manage Plugins... | = Start a Python Shell

- Record Test...
- Play Test... '~ - Line by line, enter:
' Lock View Size '
Lock View Size Custom... !

- Start a new session

reader=OpenDataFile ('hpathi/disk out ref.ex2')

Show ()
Timer Log Render ()
Output Window
Connect To Catalyst Get point data:

Python Shell pd = reader.PointData

print pd.keys ()

print pd['Pres'].GetNumberOfComponents ()
print pd['Pres'].GetRange ()

print pd['V'].GetNumberOfComponents ()

Start Trace
Stop Trace




Parallel rendering & remote vis

To set it up see:

-http://www.paraview.org/\Wiki/Reverse_connecti

on_and_port_forwarding, option 1.
REMOTEHOST=cusco.hpcc.uh.edu
IREMOTE/PATH/TO/pvserver=/share/apps/

paraview-4.3.1/bin/pvserver

- Paraview is used frequently National
Laboratories and other institutions for visualizing
data from large-scale simulations run on the
world's largest supercomputer (examples, left).

- You can use it in
parallel too. Data | Render

Server Server

Client

- Architecture:

SEAM Climate Modeling simulation with
1 billion cells modeling the breakdown of
the polar vortex, a circumpolar jet that
traps polar air at high latitudes.

CTH shock physics simulation with
over 1 billion cells of a 10 megaton ex-
plosion detonated at the center of the
Golevka asteroid.



http://www.paraview.org/Wiki/Reverse_connection_and_port_forwarding
http://www.paraview.org/Wiki/Reverse_connection_and_port_forwarding

Parallel rendering & remote vis

- ParaView must be compiled on a parallel machine. See

http://www.paraview.org/Wiki/Setting up a ParaView _
Server#Compiling

- Its libraries have to be in place:
*CMake cross-platform build setup tool (www.cmake.org)
*MPI
*OpenGL (or use Mesa 3D www.mesad3d.org if otherwise
unavailable)
*Qt 4.6 (optional)
*Python (optional)



Parallel rendering & remote vis

CE

- Connect to servers and disconnect from servers 51

B
lL:-ff—zj

(would) present you with a dialog box containing a

list of known servers you may connect to. This list of
servers can be both site- and user-specific.

- Data will automatically be partitioned and distributed
amongst processors (see paraview'’s tutorial documentation
for details)




Official documentation for details

C M [) www.paraview.org

- Set up a visualization  |lMlparaview
server

- Parallel visualization
algorithms

- Memory tracking

An Image-Basec

Extreme-Scale [

- Rendering

- and more <tware offers advanced software R&D solutions and services
) Flnd out how we can help with your next ParaView project

- http://www.paraview.org/Wiki/Main_Page



